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Quantarctica is the result of an initiative 
by the Norwegian Polar Institute (NPI) 
to develop and host a collection of freely
available geographical datasets and soft-
ware, with offline capabilities to explore 
the Antarctic region, aimed at research,
education, management and operational 
use. The current version is the fourth re-
lease of the package, with data gathered
from data centres around the world, 
based on recommendations by an inter-
national editorial board for the various
diciplines. This is a tool for and by the
user community. Data sharing is
encouraged!
                                          

   In the practical sense, Quantarctica (Quantum GIS [Since 2.0 just QGIS] + Antarctica = "Quantarctica") is a QGIS 
   project presenting a basemap of the world south of 40 degrees latitude, on top of which the end users can work with 
   preloaded scientific datasets or load their own; to create, visualise, analyse and present Antarctic geographical data.

   In published works produced using Quantarctica, you are required to cite each dataset that was used in the work.
   Quantarctica provides all dataset citation information in each layer’s Metadata tab in QGIS, in a text file in the data
   folder, and in the online Quantarctica Data Catalog. You are also required to acknowledge or cite Quantarctica and 
   the Norwegian Polar Institute in your work.

The Quantarctica package                                                                                            

QGIS. This is the software part of Quantarctica. QGIS (qgis.org) is a powerful, user friendly and 
open source geographic information system (GIS) that runs on Windows, Mac, Linux and BSD. It 
was first released in 2002, and is licensed under the GNU General Public License. It supports a 
range of vector, raster and database data formats, and connects to several types of online map 
services. The core functionality can be extended with plugins and scripting.

The basemap data. Quantarctica comes with basemap data for Antarctica and the Southern Ocean, 
featuring coastlines and ice edges, elevation contours, facility locations, place names etc., provided 
as vector data in the ESRI Shapefile format. Also included are e.g. elevation models and satellite 
imagery, provided as raster data in GeoTIFF, JPEG and JPEG2000 formats.

The scientific data. The package includes scientific data, with the following main themes: 
atmosphere, biology, environmental management, geology, geophysics, glaciology, oceanography, 
sea ice, and social science.
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The Quantarctica package or individual datasets are available for download at the project website in
three different structures:

   • The whole package as a single zip file (6 GB)
   • The whole Quantarctica project on FTP structure where any file or folder can be downloaded individually.
   • The update package which brings existing Quantarctica 3.1 users to 3.2.

   The project website also includes a gallery where the various themes and datasets can be browsed.

Quantarctica Setup                                                                                                        

Download Quantarctica. The package components mentioned above, can be downloaded from the 
project website.

The rest of this guide is based on QGIS 3.16 for Windows.

Install QGIS. Launch the QGIS standalone installer (.exe file) included in the Software folder of 
the package, and follow the instructions. When completed, double-click the QGIS project file 
Quantarctica32.qgz in the Quantarctica folder to launch the project for the first time.

Install Plugins. Beyond the core functionality, numerous plugins are available to extend it. Plugins 
can be easily installed to QGIS through the core embedded Plugin installer, and run from the 
Plugins toolbar and menu (some install to other menus). As part of the installation of QGIS, some 
plugins might be assumed handy to install. While online, click the Plugins menu in QGIS, and 
select Manage and Install Plugins, search for and install plugins, such as:

Profile Tool Value Tool
See the cell values See the value of
along a profile of the raster cells
raster layers, e.g. below the mouse
elevation cursor

   Other plugins to consider:
   • autoSaver* Auto save current project at specified intervals
   • GarminCustomMap** Export map to KMZ (for Google Earth or custom Garmin GPS map).
   • Point Sampling Tool Transfer multiple raster values to point dataset at point position.
   • Search Layers Enhanced textual searching on all QGIS layers and fields.
   • Spreadsheet Layers Load layers from spreadsheet files (ods, xls, xlsx)

   * Optionally also autosave layers in edit mode. Be careful, enabling this will save edits without user confirmation.
   ** Visit Garmin website to see which handheld GPS units support custom KMZ maps.
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First time launch: QGIS tuning                                                                                

The next step is some optional and one-time QGIS tuning and customisations.

From the Plugins menu, click Manage and Install Plugins. In the Settings tab in the appearing box, 
enable QGIS to Check for updates on startup, and select it to do so e.g. every month.

From Settings/Options menu, consider the following adjustments:
• In the General tab, change Icon size if the toolbar buttons are too big or small.
• In the Rendering tab: Set No Stretch in Rasters / Contrast enhancement dropdowns.
• In the General tab, check Override System Locale, and set to American English.
Click OK to finish.

Consider hiding rarely used toolbars from the interface. Right-click e.g. to the right of the Help 
menu, and have uncheck all but these: Attributes Toolbar, Digitizing Toolbar, Manage Layers 
Toolbar, Map Navigation Toolbar, Plugins Toolbar and Selection Toolbar.

To hide rarely used panels, perhaps the Value Tool or Browser panels, uncheck them in the 
View/Panels menu.
       
If you at any time want clean up and remove individual toolbar buttons you don’t use, go to 
Settings/Interface Customization, and uncheck them in the expanded Toolbars section.

Toolbars can be docked at any side of the interface, e.g. vertically on the left, by click, hold and 
drag the “rubber-band” section at the left or top of a toolbar                     .

Close and restart QGIS to save and apply any of these changes requiring restart to take effect.

   Some general Quantarctica recommendations
   • Rename the MyDataFolder folder in Quantarctica, to your own user name.
   • Save the default Quantarctica project as a new and personal project file in this folder.
   • Save your own data in this folder too.
   • Add your own data in your personal project file.
   • Save regularly when editing data, and do data backups.

Explore Quantarctica – Basic operation                                                                      

When opening the Quantarctica QGIS project, a basic map of Antarctica is the only visible data in 
the map canvas. However, a range of preloaded datasets are available for display in the tree 
structure in the Layers panel. Let's go through some basic operation of Quantarctica.

Activate detailed basemap. To turn on a more
detailed basemap, check the box to the left of the 
Detailed basemap group item in the Layers panel.

Navigate in the map. Click the Zoom In button       in the navigation toolbar, and draw a rectangle 
around e.g. the Antarctic Peninsula, and repeat to zoom closer in to a specific area. As you will see, 
the level of detail increases as you zoom in. Click the Pan Map button        in the navigation toolbar 
to pan around in the map. Try using the mouse wheel for even more convenient zooming.
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Toggle place names. The project includes three place
names datasets. One for overview purposes, one with
all place names in Antarctica (as reported to SCAR),
and one with undersea feature names. Now, zoom out 
to see the whole of the continent, do this by clicking 
the Zoom Full button      . Then, expand the Miscel-
laneous group by clicking the node       to the left of it,
and check the Overview place names layer. Zoom in a
step or two to see more clearly the selected Antarctic
overview names. Turn off the place names again, and
now check the SCAR Composite gazetteer layer. A lot
of points populate the map canvas. To see the actual
place name labels, zoom further in. (This kind of scale
dependent rendering is used for many layers to keep
large-area views simple and small-area views
information rich.)

Switch to satellite view. Uncheck Detailed basemap (for
performance reasons), and expand the Satellite imagery group.
From the expanded list, check the LIMA Landsat low-resolution
mosaic (240m) layer, and the image appears on top of the simple
basemap. To view the image in its native resolution, make sure
that the layer is marked in grey or blue in the layers list (meaning,
it has the focus), and click the concurrently enabled Zoom to
Native Resolution button      .

Get map feature info. Turn off all layers except the 
Simple basemap, expand the Miscellaneous group, and
check the COMNAP listed facilities layer. Zoom to the
extent of the dataset by clicking the Zoom to Layer
button      . To read the specific info on any particular
facility in the map, zoom in on one of the facilities,
make sure that the COMNAP layer is selected (shown
in gray or blue) in the layers list, click the Identify
Feature button       in the toolbar and then on a facility
point in the map. A box titled Identity Results appears,
and here are all the data about this specific facility for
you to study. Close and click e.g. on the Pan Map
button to leave identify mode.

View dataset metadata. To read the general info
about a dataset, e.g. the IBCSO Elevation model,
surface (500m) dataset in the Terrain models
group, double-click the layer in the layers list. The
Layer Properties box appears. Several tabs appear
in the left section, click the Metadata tab. The
metadata accompanies any single dataset in the
file folders also as a .TXT file.
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See layer legend. You can see any layer's legend (symbols and explanations) by expanding the tree 
node      to the left of the layer name.

Export map. Besides regular printscreens, the most straight-forward way to take your current map
view out of QGIS, is to export it into a graphical image file, like TIFF or JPEG. From the Project
menu, select Import/Export and Export map to Image. However, if you want more advanced exports
with higher resolution and perhaps a scale bar, a north arrow, a legend and maybe some other 
customisations, the New Print Layout in the Project menu is more versatile and can produce both 
vector and raster exports for your papers.

Explore Quantarctica – More useful essentials                                                           

View country specific place names. To just view e.g. the place names approved by New Zealand, 
right-click the SCAR Composite gazetteer layer, and from the appearing context menu, click Filter. 
In the appearing Query Builder, double-click country_na in the Fields list, then the equals sign in 
the Operators box, and then click the All button in the Values box. From the appearing list, double-
click New Zealand. As you can see in the box Provider Specific Filter Expression, you now choose 
to show only the place names where "country_na" = 'New Zealand'. Press OK, and you'll see only 
the names approved by New Zealand.
                                                                                                        
View attribute table. A vector dataset has an associated data table that hosts all the non-geometric 
information on the features, like the information you've seen with the Identify Feature tool in the 
Basic operation tutorial. To view more than one feature's associated data at a time, you can open the
attribute table by right-clicking the layer, e.g. the SCAR Composite gazetteer, and selecting Open 
Attribute Table. The box that appears, resembles spreadsheet software, and you can expand 
columns, sort and select records similarly as in regular spreadsheets. In this particular place name 
table, you will see only the New Zealand approved place names, because of the data query above. 
Browse and select a few of the records, like e.g. Mount McIntyre and Mount Weaver (click on the 
record number to the left, hold down the Ctrl key, and click the other). Now click the Zoom map to 
the selected rows button above the table, and minimise the table to see the selected features 
highlighted in the map. (Note: When selecting several records geographically far apart in a dataset 
table with large record numbers, the selected features might not be clearly visible among the others, 
unlinke what the selection of the two mountains in this sample produce.) Deselect with the Deselect
Features from all layers button.

Adjust image contrast. If you zoom in on any specific part of a satellite image, you can stretch the 
contrast to see the details better, e.g. fine glacier structures in Radarsat imagery. A convenient way 
to do this is with a right-click on the image in the layers list, and then Stretch Using Current Extent.

See layer without preset styling. Layers in Quantarctica comes with preset styling, including 
labeling, transparency and scale-dependent rendering settings. If this doesn't suit your needs, you 
can change the styling manually in the layer's properties, under the Symbology and Labels tabs. 
Saving the project means that the style is also saved, so if you at any point want to go back to the 
previous default styling, open the layer properties, then from the bottom Style dropdown button, 
select Restore Default.

Terrain models: Customise terrain model hillshades and contour line intervals. The Terrain 
models group contains certain layers with suffixes "virtual hillshade" and "customizable interval". 
The former are terrain models rendered as hillshades, where you can set the hillshade effect to the 

5



amount of vertical exaggeration you prefer (open layer Symbology tab and enter value in Z Factor 
box). The latter are contour lines with preset drawing rules where only the lines of preferred height 
interval are shown, but where the actual dataset contains all heights. If you prefer e.g. 1000 m 
intervals, you can set this by opening the layer properties Source tab, press the lower right Query 
Builder button, and enter "nnn"%1000=0, where nnn is the attribute name holding the height 
values. The interval value must be present in the dataset itself for this filter to be valid.

Increase readability. If symbols and labels appear to small on your computer, you can either 
change the symbol size and labels manually in the layer properties, or apply a magnification factor 
on the map canvas itself. This is done by entering the desired magnify percentage in the Magnifer 
box located in the QGIS status bar in the lower right corner.

Rotate map canvas. If your geographical area of interest is far away from the Greenwich Meridian,
you can rotate the map to how you are used to view the continent with the Rotation option in the 
status bar. Note that hillshades in the Detailed basemap group will appear different, but that virtual 
hillshades in the Terrain models group can be manually adjusted through the Azimuth box to make 
light source appear from top right corner of the map canvas, which produces the hillshade effect 
most are used to.

Working with GPS data. QGIS supports uploading and downloading of data to a range of 
handheld GPS units, directly and through GPX file import and export. (Functionality located in the 
Vector/GPS Tools menu, make sure it is enabled in the plugins manager). Also, there are some 
capabilities to connect a GPS through a serial port on the computer, or USB on some tablets, and 
have live tracking in the map as you go. (Toggle GPS Information Panel through the View/Panels 
menu entry.)                                                                                    

   Some more Quantarctica recommendations
   • If the project launches very slowly or if you use Quantarctica on a not too powerful computer, you can consider
   removing layers loaded in the default project but irrelevant to you. This will make the project launch faster. Right-
   click the group or layer in the layer list and select Remove. (Removes from the project only, not from disk.)
   • Generally, have only visible layers checked. A layer totally covering another layer (lies above it in the Layers panel,
   and without preset/custom transparency), makes the covered layer unnecessary to render, and decreases performance.
   • Although QGIS can render and work with data of different projections at the same time, it is generally recom-
   mended that when creating data, it should be projected to the default projection. This shortens rendering time.

   Further reading
   • Included in the Software folder in the Quantarctica main project component, there is the official QGIS User Guide.
   • Online resources exists on the QGIS website at https://qgis.org.

   Please read the Quantarctica_ReadMe text file in the main Quantarctica folder for general terms and disclaimer.

6

https://qgis.org/

